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Practical Computer Application XI

Practical Programs — Hand Book

Instructions:

1. One exercise from Writer, Calc and CSS, Three exercises from HTML, and Four
exercises from JavaScript are to be practiced in the practical classes.

2. Answer to any one question from Practical Book with internal choice.

3. Distribution of Marks.

l. Internal Assessment: 5 Marks

Record Book 5 Marks

Il. External Assessment: 15 Marks

(a). Writer or Calc - Procedure 10 Marks
HTML or CSS or JavaScript - Coding

(b). Execution & Output

’ Total | 20 Marks
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4, CA4 HTML - Height and Weight Table
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CA1l - FORMATTING INVOICE

CA1 | Type the following Invoice in OpenOffice Writer and apply the formatting features as given
below:
Invoice
SAIRAM MEDICAL STORES
Mobile No :9002416000 P.B.No: 617
Mail Address : sairam@gmail.com 70, New Avadi Road,
Chennai 600 010.
No. 70/162
M/S. Eswari Medical Stores, 23" Nov 2017
No: 72, N.S.C. Bose Road,
Puducherry — 6210110
Quantity (Nos) Particulars Rate Amount
20 Johnson Baby Powder 25 500
10 Nestle Milk Powder 100 1000
5 Wood Wards Gripe Water 70 350
Total
| Add: GST @ 3%
Net Payable
For Sriram Medical Stores
Sales Manage

e Use formula to calculate Total and Net Payable.
Procedure
Step-1. Open Office Writer and choose Text document or File>New—>Text Document.
Step-2. Type the text and apply the format as per the given format.

Note: Select the required text before formatting.

Text Format Method

INVOICE Center and apply red Ctrl + E and choose Red color from font
color pallete or any method.

SRIRAM MEDICAL STORES Center and apply blue Ctrl + E and Blue color from font color
pallete or any method.

Eswari Medical Stores Bold Ctrl + B or any method.
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Step-3. Create a table using any one of the method Ctrl + F12 or Insert - Table or Table = Insert
-> Table or Insert Table icon from toolbar, with 4 columns and 7 rows.

Step-4. Enter the data as per the given format.

Step-5. Select first three columns in 5™ row and Right Click = Cell > Merge and type as “Total”
Step-6. Repeat Step-5 for 7" Row, and type as “Net Payable”

Step-7 To do calculation In table click on table tools -> layout -> formula

Step-8. To find the Amount of Johnson baby powder = (a2*c2)

Step-9. To find the Amount of nestle milk powder = (a3*c3)

Step-10. To find the Amount of wood wards gripe water = (a4*c4)

Step-11. To find the Total, enter the following formula at Total -> Amount Column as = d2+d3+d4 or
=sum(d2:d4)

Step-12. To find GST @ 3% enter the formula as =b5*0.03

Step-13. To calculate Netpayable amount, Enter the formula s = b5+d6

Output
Invoice
SAIRAM MEDICAL STORES
Mobile No :9002416000 P.B.No: 617
Mail Address : sairam@gmail.com 70, New Avadi Road,
Chennai 600 010.
No. 70/162
M/S. Eswari Medical Stores, 23 Nov 2017
No: 72, N.S.C. Bose Road,
Puducherry — 6210110
Quantity (Nos) Particulars Rate Amount
20 Johnson Baby Powder 25 500
10 Nestle Milk Powder 100 1000
5 Wood Wards Gripe Water 70 350
Total 1850
| Add: GST @ 3% 55.5
Net Payable 1905.5
For Sriram Medical Stores
Sales Manage
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CA2 - INTEREST CALCULATION

‘ CA-2 ‘ Create statement of interest using OpenOffice Calc with the following particulars: \

Sara Ltd., sells goods. Their policy is to charge interest @ 2% p.a., for the number of days. From the
following data, find out the amount to be collected from each customer. Assume 365 days in the
year.

Customer Sales Date of Sale No. of days Date of
Settlement
Tharani 25000 10/04/2017 60
Mahalakshmi 14000 28/05/2017 30
Kumar 28000 14/07/2017 45
Arulmozhi 54000 03/08/2017 90
Procedure

Step-1. Open OpenOffice Calc and choose Spreadsheet or File > New - Spreadsheet.

Step-2. Type the Headings in cell Al to E1 (Customer, Sales, Date of Sale, Number of days and Date
of settlement) as per the given data.

Step-3. Incell F1 and G1 type (Interest Amt and Amount to be paid) respectively.

Step-4. In cell E2 enter the formula = C2 + D2 to arrive the date of settlement and to the remaining
cells (E3 to E5), Use Edit = Fill 2> Down command

Step-5. In cell F2 enter the formula = ROUND((B2*2/100)*D2/365,) to arrive the Interest amount to
the remaining cells (F3 to F5). Use Edit = Fill > Down Command

Step-6. In cell G2 enter the formula = B2 + F2 to arrive the Amount to be paid to the remaining cells
(G3 to G5). Use Edit = Fill > Down Command.

Output
Amount
Customer Sales Date of Sale No. of Date of Interest to be
days Settlement Amt Paid
Tharani 25000 10/04/2017 60 09/06/2017 82 25082
Mahalakshmi 14000 28/05/2017 30 27/06/2017 23 14023
Kumar 28000 14/07/2017 45 28/08/2017 69 28069
Arulmozhi 54000 03/08/2017 90 01/11/2017 266 54266
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CA3 - FORM DESIGN

‘ CA-3 ‘ Write an HTML code to design a form like the one shown below.

Registration Form

User Name : | |
Password : | |
Re-type Password : | |

Gender: O Male O Female

Additional Information

Optional Subject : Computer Technology \/

D Put me on mail list

Reset Submit

Coding

<html>

<head>

<title>User Registration</title>

</head>

<body>

<h1 align = center>Registration Form</h1>

<form id=reg_form method=post action="">

User Name:<input type=text name=uname/><br><br>
Password:<input type=password name=pword1/><br><br>
Re-type Password: <input type=password name=pword2/><br><br>
Gender:

<input type=radio name=male value="M"/>Male

<input type=radio name=female value="F’/> Female

<h2 align=center> Additional Information </h2>

Optional Subject:

<select name=subj>
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<option value = CT> Computer Technology
<option value = Paint> Painting
<option value = SG> Sports and Games
</select>
<br><br/>
<input type = checkbox name=mail /> Put me on mail list <br><br>
<input type = reset value=Reset>
<input type = submit value=Submit>
</form>
</body>
</html>
Output
. e | (@]
( :w\% 8] Calsers 60995280 0 + G || @ user Regaton ‘ | el K5 H\% &) ClUser 97280 O + © | @ User Regtrton ‘ ‘ AR
File Edit View Favorites Tools Help File Edit View Favorites Tools Help
Registration Form Registration Form
UerName| | UsaNamelfomd |
Password] | Basswordfessasnnsnses |
et [ ] Retype P rsmrvr |
Gender: OMale O Female Gender: ®Male O Female
Additional Information Additional Information
Optional Subject: Optional Subject
[ Put me on mail list Put me on mai list
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CA4 - HEIGHT AND WEIGHT TABLE
‘ CA-4 ‘ Write an HTML code to display the following
Height and Weight
Name Class Height Weight
Mani Xll-G 5’0" 45
Vasu XI—-H 5’4" 49
Murali Xi-B 5’1" 51
Pallavai Xil-D 4’5" 50
Coding
<htmi>
<head>
<title>Height and Weight Table</title>
<head>
<body>
<table border=10>
<caption>Height and Weight </caption>
<tr>
<th width=40%> Name </th>
<th width=20% Class </th>
<th width=20% Height </th>
<th width=20% Weight </th>
</tr>
<tr>
<td> Mani </td>
<td> XIl - G </td>
<td>5’0"> </td>
<td> 45 </td>
</tr>
<tr>
<td> Vasu </td>
<td> Xl — H </td>
<td> 5’4"”> </td>
<td> 49 </td>
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</tr>

<tr>

<td> Murali </td>
<td> XI - B </td>
<td>5’1"> </td>
<td> 51 </td>
<[tr>

<tr>

<td> Pallavai </td>
<td> Xl - D </td>
<td> 4’5”> </td>
<td> 50 </td>
</tr>

</table>

</body>

</html>

Output

P

o —— = | B | = |

< J=>)| £ C\Users\604979528\D O ~ & || &8 Height =

&

File Edit Wiewy Fawvorites Tools Help

Height and Weight

| | |
|11 — Gl[570= |45
Px—8|[574 = [la9

IX1—B |[5717= [[51
|11 — D|[4° 5= [|50
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CA5 - NESTED LIST

‘ CA-5 ‘ Write an HTML code to create a webpage to display the following sets of lists:

1. Tamilnadu e Languages
a. Chennai o Tamil
b. Madurai o Malayalam
o Telugu
2. Andhra Pradesh e Science
a. Amaravathi o Physics
b. Vijayawada o Chemistry
o Zoology
3. Kerala e Humanities
a. Thiruvananthapuram o History
b. Cochin o Commerce
o Economics

Coding
<htmi>
<head>
<title> Sets of Lists </title>
</head>
<body>
<0oL>
<LI> Tamilnadu
<OL type=a>
<LI> Chennai
<LI> Madurai
</oL>
<LI> Andhra Pradesh
<OL type=a>
<LI> Amaravathi
<LI> Vijayawada

</oL>

<LI> Kerala
<OL type=a>
<LI> Thiruvananthapuram
<LI> Cochin

</OL>
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</0L>
<uL>

<LI> Languages
<UL type=circle>
<LI>Tamil
<LI>Malayalam
<LI>Telugu
</UL>
<LI> Science
<UL type=circle>
<LI>Physics
<LI>Chemistry
<LI>Zoology
</UL>
<LI> Humanities
<UL type=circle>
<LI>History
<LI>Commerce

<LI>Economics

</uL>
</UL>
</body>
</html>
Output
== =]
’_.| a C:‘\U:Ers‘\EGfQTQSES\D o~ || @& sets of Lists | | A
1. 'l?amil.t:adu N S
e
T Amaracath
N Ke:)éla\ Hjayawada
5 ot P
: 5'515:1 c;hys?cs
. > Zootomy”
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CA6 - FORMATTING WEBPAGE

‘ CA-6 ‘ Create a webpage as given description using CSS

Tamil

Tamil is a Dravidian language predominantly spoken by the Tamil people of India and Sri Lanka, and
by the Tamil diaspora, Sri Lankan Moors, Burghers, Douglas, and Chindians. Tamil is an official
language of two countries: Sri Lanka and Singapore.

It has official status in the Indian state of Tamil Nadu and the Indian Union Territory of Puducherry.
It is used as one of the languages of education in Malaysia, along with English, Malay and Mandarin.

Tamil is spoken by significant minorities in the four other South Indian states of Kerala, Karnataka,
Andhra Pradesh and Telangana and the Union Territory of the Andaman and Nicobar Islands. It is
one of the 22 scheduled languages of India.

Description:
Element Font Style Alignment Color

H1 Arial Black - Center Border 2px solid
blue

P1 Century Bold - Red

P2 Boockman Old Style Italic - Blue

P3 Century Gothic - - Green

Note: Create two files. 1. Mystyie.css and 2. CA6.htmi

Coding -1

Mystyle.css

H1

{

Font-family: ”Arial Black”;

Text-align:center;

Border : 2px solid blue;

}

P1

{

Font-family: “Century”;

Font-style : Bold;

Color : Red;

}

P2

{

Font-family: “Bookman Old Style”;
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Font-style : Italic;
Color : Blue;

}
P3

{

font-family: “Century Gothic”;
color : Green;

}

Coding - 2

CA6.htm

<html>

<head>

<title>Tamil</title>

<link rel="stylesheet” type="text/css” href="mystyle.css”>
</head>

<body>

<H1>Tamil</H1>

<br>

<P1>

Tamil is a Dravidian language predominantly spoken by the Tamil people of India and Sri Lanka,
and by the Tamil diaspora, Sri Lankan Moors, Burghers, Douglas, and Chindians. Tamil is an official
language of two countries: Sri Lanka and Singapore.

</P1>
<br>
<br>
<P2>

It has official status in the Indian state of Tamil Nadu and the Indian Union Territory of
Puducherry. It is used as one of the languages of education in Malaysia, along with English, Malay
and Mandarin.

</P2>
<br>
<br>
<P3>

Tamil is spoken by significant minorities in the four other South Indian states of Kerala, Karnataka,
Andhra Pradesh and Telangana and the Union Territory of the Andaman and Nicobar Islands. It is
one of the 22 scheduled languages of India.

</P3>
</body>
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</html>
Output
[ ]
e(:_)jﬂ & C\Users\604979528\0e: O = ¢ ” @ Tamil ‘ | b g Ges
File Edit View Favorites Tocols Help
Tamil

Tamil 1s a Dravidian language predomnantly spoken by the Tamil people of India and Sr1 Lanka, and by the Tamal
diaspora, Sr1 Lankan Moors, Burghers, Douglas, and Chindians. Tamil 1s an official language of two countries: Sr1
Lanka and Singapore.

It has official status in the Indian state of Tamil Nadu and the Indian Union Territory of Puducherry. It 1s used as one
of the languages of education in Malaysia, along with English, Malay and Mandarin.

Tamil 1s spoken by significant minorities in the four other South Indian states of Kerala, Karnataka, Andhra Pradesh
and Telangana and the Union Territory of the Andaman and Nicobar Islands. It is one of the 22 scheduled languages of
India.

CA7 - DISPLAY TEXT
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‘ CA-7 ‘ Create a webpage using JavaScript to display the following text. \

Welcome to JavaScript
State Council of Education Research and Training (SCRET),

Tamilnadu, Chennai.

Coding

<html>

<head>

<title> Display text using JavaScript</title>

</head>

<body align=center>

<p>

<script>

document.write("<h1 aligh=center>Welcome to JavaScript<br>");
document.write("State Council of Educational Research and Traning(SCERT),<br>");

document.write("Tamilnadu,Chennai.</h1>");

</script>
</p>
</body>
</html>
Output
L = B |
B filey///C:/Users/6 x| [l filex///C:/Users/6 X | I filex//C:/Users/6 x| I filex//C:/Users/6 > [l Display text usine X | + ~
C 88 ™ | filey//C/Users/ /604579528 /Desktop/one.html [ S >
+ Flipkart Jebong.com @ Amazenin AliExpress [ Successfully Logout @ National Hligibility T= [l Vodafone India - Mz >

Welcome to JavaScript
State Council of Educational Research and Traning(SCERT),
Tamilnadu,Chennai.

CA8 - MULTIPLICATION TABLE

‘ CA-8 ‘ Create a webpage using JavaScript to display multiplication table by prompting number of |
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\ ‘ rows and columns. ‘

Coding

<html>

<head>

<title>Multiplication Table</title>

</head>

<body>

<script type="text/javascript">

var rows=prompt("How many rows for your multiplaction table?");

var cols=prompt("How many columns for your multiplication table?");

if(rows =="" | | rows == null)
rows = 10;

if(cols =="" | | cols == null)
cols = 10;

createTable(rows,cols);

function createTable(rows,cols)

{ var j=1;
var output = "<table border='1" width='500" cellpadding='5">";
for(i=1;i<=rows;i++)
{ output = output + "<tr>";

while(j<=cols)

{ output = output + "<td>" + i*j + "</td>";
i=j+; }
output = output + "</tr>";
i=1 }
output = output + "</table>";
document.write(output); }
</script>
</body>
</html>
Output
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Explorer User Prompt

Script Prompt: oK

Haw mary rows for your multiplaction table?
Cancel

12

Explorer User Prompt

Script Prompt: oK

Haw many columns for your muttiplication table?

dil TS

Cancel

[

- B
() )[E cusensusmsisive £~ ¢ || @ wutiplicstion Teble ] o e

File Edit View Favorites Tools Help

1 2 3 1 5 6

2 1 6 8 10 12

3 6 9 12 15 18

4 8 12 16 20 21

5 10 15 20 25 30

6 12 18 24 30 36

7 14 21 28 35 2

$ 16 24 32 40 48

9 18 27 36 45 54

10 20 30 10 50 60

11 2 33 1 55 66

12 2 36 18 60 7
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CA9 - DISPLAY WEEKDAYS IN WORDS

CA-9 | Create a webpage using JavaScript to display Weekday in words by getting input as a
number using switch.

Coding
<htmi>
<head>
<title> Weekday </title>
</head>
<script type="text/javascript">
var n=prompt("Enter a number between 1 and 7");
switch (n)
{ case (n="1"):
document.write("Sunday");
break;
case (n="2"):
document.write("Monday");
break;
case {n="3"):
document.write("Tuesday");
break;
case (n="4"):
document.write("Wednesday");
break;
case (n="5"):
document.write("Thursday");
break;
case (n="6"):
document.write("Friday");
break;
case (n="7"):
document.write("Saturday");
break;
default:
document.write("Invalid Weekday");

break; }
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</script>
</html>
Output
Explorer User Prempt @
Script Prompt:
Enter a number between 1and 7
Cancel |
A
N F=1 | EoR (T
( 3:) '@'|@ CA\Users\604970528\De: O ~ & H & Weekday x | IANIE
File Edit View Favorites Tools Help
Thursday
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CA10 - LOGIN FORM

CA-10 | Create a Form using JavaScript to get username, password and address, validate the
inputs.

Coding

<htmi>

<head>

<script type="text/javascript">

function sub()

{

if(document.getElementByld("t1").value == "")
alert("Please Enter your Name");

else if(document.getElementByld("t2").value == "")
alert("Please Enter a Password");

else if(document.getElementByld("t2").value != document.getElementByld("t3").value)
alert("Please Enter Eorrect Password");

else if(document.getElementByid("'t4").value == "")
alert("Please Enter Your Address");

else

alert("Form has been Submitted");

}

</script>

</head>

<body>

<form>

<p align="center">

User Name:<input type="text" id="t1"><br><br>
Password:<input type="text" id="t2"><br><br>
Confirm Password:<input type="text" id="t3"><br><br>
Address:<textarea rows="2" cols="25" id ="t4"></textarea><br><br>
<input type="button" value="submit" onclick="sub()">
<input type="reset" value="clear all">

</p>

</form>

</body>

</html>
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Practical Computer Application XI

Output

=3 ECR F%=)
@@ £ C\Users\604979528\De: © ~ € || @ C:\Users\604979528 Deskt... T %f 553

File Edit View Faverites Tools Help

User Na_tne:| |

Passwm'd:| |

Confirm Password:| |

Address:

| submit || clear all
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Practical Computer Application XI

Internal Choice for the Programs

Qno. | Question Qno. | Question Choice

CAl1 | Writer — Formatting Invoice CA6 CSS — Formatting Webpage CAlor

CA10

CA2 | Calc—Interest Calculation CA7 | JavaScript — Display Text CA2 or CA8

CA3 | HTML — Form Design CA8 | JavaScript — Multiplication Table CA3 or CA9

CA4 | HTML — Height and Weight Table | CA9 | JavaScript — Display Weekdays in CA4 or CA6
Words

CA5 | HTML — Nested List CA10 | JavaScript — Login Form CAS or CA7
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